VDI RESOURCE COMPARISON: VMWARE HORIZON VIEW
5.2 VS. CITRIX XENDESKTOP 7

TIME AND RESOURCES SAVED.

VMware Horizon View"5.2 hosted on VMware vSphere® 5.1 delivered key advantages

compared to Citrix®XenDesktop® 7 hosted on Citrix XenServer® 6.2
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Virtual Desktop Infrastructure (VDI) offers unparalleled flexibility and security
that traditional desktop computing cannot match. However, burdens on datacenter
resources hosting the VDI solution can increase with the growth of a VDI user base. An
advantageous solution can be key in mitigating the overall impact of new users on
datacenter resources without sacrificing the flexibility and security that VDI offers. As
the number of VDI users grows, challenges such as keeping the disk footprint required
for applications and user data to a minimum, maintaining non-disruptive security and
protection for users, and ensuring rapid deployment of new virtual desktops within the
system can all negatively affect cost and productivity. Organizations unprepared for
these challenges can benefit from a well-designed VDI solution that alleviates these time
and resource burdens.

Here in the Principled Technologies labs, we performed a multi-feature VDI
comparison between VMware Horizon View 5.2 hosted on VMware vSphere 5.1 and
Citrix XenDesktop 7 hosted on Citrix XenServer 6.2. In our testing, we measured disk
space usage for a persistent virtual desktop, the impact of anti-virus (AV) scans on
datacenter resources, and the speed each solution can deploy virtual machines (VMs).
We found that VMware Horizon View 5.2 hosted on VMware vSphere 5.1 was able to do
all three things faster or better than Citrix XenDesktop 7 hosted on Citrix XenServer 6.2.
Our results show the time- and resource-saving qualities that any VDI user base would

appreciate.
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The advantages of VMware Horizon View 5.2

The two VDI solutions we tested, VMware Horizon View 5.2 and Citrix
XenDesktop 7, are similar in basic function and offer the traditional benefits associated
with VDI, however there are key differences that can potentially affect datacenter
resources and desktop user productivity. VMware Horizon View offers disk reclamation
and the Citrix solution does not have disk reclamation capabilities. VMware Horizon
View reclaimed 27 percent of disk space from its virtual desktop and returned it as
ready for general use, making more room on the datastore for other desktop images,
applications, or user data. Citrix XenDesktop 7 could not reclaim any disk space.

Without an anti-virus solution, any user is vulnerable to a malicious attack.
Providing security through AV scans at a virtual appliance level, the agent-less VMware
Horizon View 5.2 was more efficient than Citrix XenDesktop 7. Because the vShield
Endpoint AV scans were not performed at the VM level, the VMware solution utilized 57
percent less CPU and required 26 percent less disk 10 than the agent-based Citrix
solution, which performed an AV scan at the VM level.

As the number of VDI users grows, deployment can take more time from the IT
staff of a large business. When deploying new VMs, we found VMware Horizon View 5.2
was 38 percent faster than the Citrix XenDesktop 7 solution.

Space reclamation: virtual clean-up

Locally installed applications on persistent VMs in a VDI environment may
require higher storage capacity even after users expunge out-of-date files or attempt to
remove excess data from their folders. A large organization using virtual desktops can
easily fill a typical storage array, requiring additional datacenter resources to allow daily
operations to continue. These organizations often allocate additional storage capacity to
compensate for the “creep” of VDI images.

The VMware disk reclaim operation looks for previously written blocks on a disk
that currently are not in use by the guest file system. Once found, the VMware Horizon
View solution reclaim feature restores them to the hypervisor as unused blocks. The
result is less wasted disk space on the datastore, which translates to a reduced need for
additional allocated storage and potentially lower infrastructure costs

We used an EMC VNX 5500 storage array in our testing, which is capable of thin
provisioning. Thin provisioning works at the standard shared storage level and allows
clone creation of either individual virtual machines or the entire volume containing the
virtual desktops. Virtual clones are created at the storage layer. Thin provisioning refers
to several reduction methods that help save space in a VDI environment:

e Removes unused space in a virtual disk file on the virtual machine
e Clones a virtual disk file within the same volume of many virtual

machines so that writes go to a small snapshot and share a base image
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e Within a shared storage device, thin clones the entire volume used by a
set of cloned virtual machines
Space reclamation meant more available disk space for other applications. On a
VM with 15.01 GB of application and user data, VMware Horizon View reclaimed 3.99
GB of space. On a similar VM with 14.77 GB of application and user data, Citrix
XenDesktop 7 reclaimed zero GB of space. Figure 1 shows the changes to disk space of a

VM before and after space reclamation.
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vShield: efficient and reliable security from any access point

Virtualized datacenters and desktops should receive the same protection that
physical machines do. Security for employees that access VDI from multiple locations is
a high priority and a typical virus scan should not interfere with productivity. Traditional
agent-based anti-virus scans are not specifically designed for virtual desktop
deployments and can require a significant amount of resources. When traditional anti-
virus solutions simultaneously initiate scans or schedule security updates on all VMs of a
single physical host, an “AV storm” can result, creating an extreme load on the system
and reducing performance for all desktop users on the server.

VMware vShield Endpoint protects virtual machines and desktops against
viruses while reducing the resource footprint in the datacenter. In our tests, we
protected virtual desktops with vShield Endpoint allowing the hypervisor to conduct AV
operations via a vShield Endpoint virtual appliance. Because the virtual appliance
executes AV updates and scanning, expenditure of server resources is minimized.

This type of protection is referred to as agent-less and is how the combination

of vShield Endpoint and Trend Micro Deep Security work on VMware Horizon View 5.2.
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Rather than users performing individual scans at the virtual desktop level, one virtual
appliance connects to each virtual machine host and performs the anti-virus scans. With
vShield Endpoint on Horizon View, the anti-virus engine and signature files are on the
virtual appliance. Updating only the virtual appliance eliminates the burden of
simultaneous signature file updates to each virtual desktop. In addition, vShield
Endpoint staggers scanning of virtual machines managed by the virtual appliance.
vShield Endpoint provides information to the anti-virus engine about which host the
virtual machine is running on, the anti-virus scanner then staggers the on-demand scans
on the same host.

VMware vShield Endpoint in VMware Horizon View 5.2 eliminates anti-virus
storms that affect the performance of virtual machines, offloads anti-virus functions to a
separate security virtual appliance, thereby freeing up virtual desktop system resources,
and utilizes a small-footprint driver on each desktop that installs with VMware Tools. No
additional provisioning is required. The anti-virus scanner and virus signatures are
installed only on the virtual appliance, saving space on each desktop and reducing the
potential attack surface because there is no agent to compromise. In VMware Horizon
View, vShield Endpoint automatically sends the latest protection updates to virtual
desktops and configures changes to the anti-virus software in the virtual appliance, not
in each desktop. Maintaining, patching, and updating anti-virus agents occur on the
virtual appliance.

VMware vShield Endpoint and Trend Micro Systems Deep Security provide an
agentless security solution designed for virtualized datacenters and desktop virtual
machines. vShield Endpoint enables agentless virtual machine introspection, monitoring
current, new and reactivated virtual machines to ensure up-to-date security. Deep
Security uses a dedicated, security-hardened virtual appliance that integrates with
vShield APIs to protect virtual machines from network- and file-based threats. vShield
Endpoint then enables Deep Security to communicate with the guest virtual machines to
implement security operations such as anti-virus scans. This approach protects the
virtual server, desktop network and file systems without deploying in-guest security
agents.

We found that vShield Endpoint used 57 percent less CPU and 26 percent less
disk 10 on VMware Horizon View 5.2 than the agent-based A/V solution on Citrix
XenDesktop 7. Figure 2 shows the difference in CPU utilization on a host during a 50

virtual machine anti-virus scan.
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Agent-less security consumed less disk |0 than the agent-based security. Figure
3 shows the difference in disk utilization on the host during a 50 virtual machine anti-

virus scan.
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Citrix XenDesktop 7 disk operations are initially low due to host CPU
overutilization; however, disk 10 rapidly increases as host CPU becomes available and
more virtual machines start to perform the A/V scan simultaneously.
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Rapid Deployment: agility to support changing users requirements

Deployment speed is an important aspect of any dynamic datacenter.
Deployments not only affect IT staff but also the activities of end-users. By reducing
deployment time, administrators are able to fulfill end-user requests in a timelier
manner and with greater efficiency. Less time deploying VMs means administrators
have more time to focus on managing other critical aspects of the data center. VMware
Horizon View 5.2 together with View Composer API for Array Integration (VCAI) allows
administrators to save time and resources while keeping up with the demands of users.

In our testing, we found VMware Horizon View 5.2 had 38 percent faster
deployment than Citrix XenDesktop 7. VMware Horizon View deployed 100 VMs in just
over 24 minutes while Citrix XenDesktop deployed 100 VMs in just under 39 minutes.
The Citrix XenCenter® limitation of 25 concurrent operations per pool added time to
deployment of the 100 VMs for Citrix XenDesktop.! Figure 4 shows the time it took to
deploy 100 VMs on each system using default settings. ESXi host had VAAI enabled.

VMware Horizon View . Deployment time advantage
Citrix XenDesktop 7
5.2 for VMware
Total time to deploy 100 VMs 0:24:11 0:38:56 38%

Figure 4: Time in hours:minutes:seconds to deploy 100 VMs with default settings.

VCAI leverages capabilities of VMware vSphere and some NAS storage arrays
that have the VAAI NAS native snapshot capability, like the EMC VNX 5500.2 This
timesaving VCAI feature allows for offloading the creation of linked clones to the
storage array. Using VCAI reduced storage throughput, and improved CPU utilization
and deployment times.

With a VAAI-disabled ESXi host, Citrix XenDesktop deployed 100 VMs in more
than 35 minutes. To compare the advantages of VCAI, Figure 5 shows the time it took to
deploy 100 VMs and CPU utilization on two ESXi hosts, one with VAAI enabled and the
other one with VAAI disabled.

VAAI-enabled ESXi VAAI-disabled ESXi Percentage improvement
Total time to deploy 100 VMs 0:24:11 0:35:40 32%
Average CPU % during
deployment 47.4 52.4 10%

Figure 5: Time in hours:minutes:seconds to deploy 100 VMs.

1 support.citrix.com/serviet/KbServlet/download/34966-102-704363/CTX137837 XenServer%206 2 0 Configuration%20Limits.pdf
2 Currently, VCAI is available in Tech Preview but VMware Horizon View 5.3 will support it.
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host.

Figure 6: CPU utilization and 10
operations on both a VAAI-enabled ESXi
host for VMware Horizon View and a
VAAI-disabled ESXi host for Citrix
XenDesktop during VM deployment.
Lower numbers are better.

Figure 6 shows the CPU utilization and disk IO operations in a VAAI-enabled ESXi
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For detailed information about disk utilization, see Appendix B.
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IN CONCLUSION

A well-designed, feature rich VDI solution can make a significant difference in
maximizing datacenter resources efficiency, and minimizing unwanted downtime.
Failure to do both these things can drive up per user costs and affect user satisfaction.
VMware Horizon View 5.2 reclaimed 27 percent of its previously used disk space from
its virtual desktop, ran more efficient AV scans, and when deploying VMs, the VMware
solution was faster than the Citrix solution by 38 percent. If your business needs to
manage the time and resource burdens created by a VDI user base, VMware Horizon
View 5.2 on VMware vSphere 5.1 provides strong advantages over Citrix XenDesktop 7
hosted on Citrix XenServer 6.2.
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APPENDIX A — SYSTEM CONFIGURATION INFORMATION

Figure 7 provides detailed configuration information for the test systems.

System

HP ProlLiant BL460c Gen8 Server Blade

Enclosure / chassis

Blade enclosure / chassis

HP BladeSystem c7000 Enclosure with 2x HP Virtual
Connect FlexFabric 10Gb/24-port modules

Power supplies

Total number

6

Maximum wattage of each (W)

2,400 Platinum

Cooling fans

Total number 10

Dimensions (h x w) of each 4" x 4"

General

Number of processor packages 2

Number of cores per processor 8

Number of hardware threads per core 2

CPU

Vendor Intel®

Name Xeon®

Model number E5-2690
Stepping C1

Socket type LGA2011

Core frequency (GHz) 2.90

Bus frequency (GT/s) 8.0

L1 cache 32 KB+ 32 KB (per core)
L2 cache 256 KB (per core)
L3 cache (MB) 20

Platform

Vendor and model number

HP ProlLiant BL460c Gen8 Server

Motherboard model number

HP 654609-001

BIOS name and version

HP 131 12/14/2012

BIOS settings

Power policy set to Max Performance

Memory module(s)

Total RAM in system (GB)

128

Vendor and model number

Samsung® M393B1K70DHO-YH9

Type

DDR3 PC3L-10600R

Speed (MHz) 1,333

Speed running in the system (MHz) 1,333

Size (GB) 8

Number of RAM module(s) 16

Chip organization Double-sided
Rank Dual

Multi-feature VDI comparison: VMware Horizon View 5.2 vs.
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System

HP ProlLiant BL460c Gen8 Server Blade

Hard drives

Vendor and model number

HP EGO300FBDSP

Number of drives in system 2

Size (GB) 300

Buffer size (MB) 16

RPM 10,000

Type SAS

Controller HP Smart Array P220i

Network adapter (mezzanine card)

Vendor and model number

HP FlexFabric 10GB dual-port adapter #647584-001

Figure 7: Detailed configuration information for our systems under test.

About the EMC VNX 5500 storage array

The EMC VNX 5500 storage array is a tiered storage solution that provides several options for capacity and

performance levels to best meet your company’s needs. The EMC VNX uses FAST Cache to intelligently tier storage

based on the applications being used, automatically moving frequently read data to high-performance SSDs to provide

both high capacity and high performance. Figure 8 provides detailed configuration information for the storage array. To

learn more about the EMC VNX series, visit www.emc.com/storage/vnx/vnx-series.htm.

System EMC VNX 5500 storage array
Storage

Number of 15-disk processor enclosures |1

Power supplies

Total number | 2

Disk array enclosures

Number of 25-disk array enclosures 1

Number of 15-disk array enclosures 1

Data movers

Number of VNX 5500 data movers 2

Disks

Number of 200GB SSDs 8

Number of 600GB SAS drives 25
Operating system

Name Unisphere

Figure 8: Detailed configuration information for the storage.

Multi-feature VDI comparison: VMware Horizon View 5.2 vs.

Citrix XenDesktop 7

A Principled Technologies test report 10



http://www.emc.com/storage/vnx/vnx-series.htm

APPENDIX B — RESOURCE UTILIZATION INFORMATION

The following detailed information shows |0 operations our anti-virus and deployment testing components in

both configurations. Figure 9 shows the NFS Reads and Writes for VMware Horizon View 5.2 in our 50-VM anti-virus

scan.
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Figure 9: Detailed IOPS for VMware Horizon View during our anti-virus scan.

Figure 10 shows the NFS Reads and Writes for Citrix XenDesktop 7 in our 50-VM anti-virus scan.
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Figure 10: Detailed IOPS for Citrix XenDesktop during our anti-virus scan.

Figure 11 shows the Reads and Writes for VMware Horizon View on a VAAI-enabled ESXi host during
deployment of 100 VMs.
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Figure 11: Detailed IOPS for VMware Horizon View during a 100-VM deployment.

Figure 12 shows the Reads and Writes for Citrix XenDesktop on a VAAI-disabled ESXi host during deployment of

100 VMs.
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Figure 12: Detailed IOPS for Citrix XenDesktop during a 100 VM deployment.
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APPENDIX C- HOW WE TESTED

Here, we explain the detailed steps we followed to set up our test scenario. Figure 13 shows our test

environment.

Cisco Nexus 5010 10Gb switch

VI ESEMIES

i

o SEm= HP BladeSystem ¢7000 Enclosure
with 5x BL460c Gen8 blade server

EMC VNX5500 Unified Storage

Figure 13: A sample diagram of the environment used in our testing.
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Figure 14 presents the infrastructure layout we used to configure the VMware View and Citrix XenDesktop

environments.

# of
VM name Hosted OS Role (s) Server Memory
vCPUs
ADO1 Win 2008 R2X64 | \ b pomain controller, DHCP, DNS, NTP Infrastructure | 4 GB 2
Enterprise
View connection Win 20(.)8 R2 x64 VMware View Connection Server Infrastructure 4GB 2
Enterprise
. XenDesktop Delivery Controller, License
XenDesktop Win 20(.)8 R2 x64 Sever, Studio, Director, StoreFront, SQL Infrastructure 4GB 2
Enterprise
Server.
PVS Win 20(.)8 R2 x64 XenDesktop Provisioning Services Infrastructure 4GB 2
Enterprise
vCenter Win 2098 R2 x64 | VMware Virtual Center, SQL server, Infrastructure 3 GB 4
Enterprise XenCenter
Trend Micro Win 2098 R2 x64 | Trend Micro Deep Security Manger, SQL Infrastructure 3GB 4
Manager Enterprise server
vShield Manager | Linux x64 vShield Manager Infrastructure 8 GB 2
View-vDT’s WIndOV\.IS 7x64 VMware View Virtual Desktops Server under 2GB 1
Enterprise test
XD-vDT’s WIndOV\.IS 7x64 XenDesktop virtual desktops Server under 2GB 1
Enterprise test

Figure 14: Layout of the infrastructure environment in out tests.

Setting up the storage

Setting up the external storage FAST Cache and Storage Pool
1. Open EMC Navsphere.

2. Login as sysadmin

3. Click System—>System Management—>Manage Cache.

4. Inthe VNX5500 storage system properties, click the FAST Cache tab, and click Create.
5. Select Enclosure 1 Disk 1-4, and click OK.

6. Click Storage—>Storage Configuration—>Storage Pools.

7. Click Create.

8. Select Storage Type= Pool

9. Click OK.

10. Righ-click Pool 0, and select create LUN.

11. In the General tab, select Pool O, RAID 5.

12. Under LUN properties, select 830GB capacity and 10 for the number of LUNSs to create.
13. Click Storage—>LUns, and select all the available LUNs.

14. Click Add to Storage Group.

Multi-feature VDI comparison: VMware Horizon View 5.2 vs.
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15. Select available storage group, and click OK.

Creating File Systems
1. Open Storage—>Storage Configuration—>File Systems.
2. Click Create:

a. Select Create from Storage Pool.

b. File System name= ViewNFS

c. For Storage pool=, select pool0

d. For Capacity, type 2048GB

e. Select VMware VAAI nested clone support.
3. Click OK.

Click Create:

a. Select Create from Storage Pool.

b. File System name= XDNFS

c. For Storage pool=, select pool0

d. For Capacity, type 2048GB

e. Select VMware VAAI nested clone support.
5. Click OK.

Creating NFS Exports
1. Open Storage—>Shared Folders—>NFS
2. Click Create:
a. Select data mover 2.
b. File System = ViewNFS
c. Add the host to the Read/Write Host group
3. Click OK.
4. Click Create:
a. Select data mover 2.
b. File System = XDNFS
c. Add the host to the Read/Write Host group
5. Click OK.

Installing VMware ESXi 5.1 on server under test and infrastructure server
1. Insert the installation media, and select Boot from disk.

At the VMware Installer screen, press Enter.

At the EULA screen, press F11 to Accept and Continue.

Under Storage Devices, select the appropriate virtual disk, and press Enter.

Select US as the keyboard layout, and press Enter.

Enter the Root password twice, and press Enter.

Press F11 to start installation.

© N o v kA wWwN

After the server reboots, press F2 and enter root credentials.
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9.

10.
11.
12.
13.
14.
15.
16.

Select Configure Management Network, and press enter.

Select the appropriate network adapter, and select OK.

Log into the server using the VMware vSphere client.

Select the Configuration tab, and click Networking.

Click Add Networking...

Create a virtual machine network called PRIV-NET and storage network called Storage-NET.
Click on the Configuration tab, and select Time configuration to configure server time.

Click DNS and Routing, and confirm the settings.

Configuring datastores on VMware ESXi 5.1 server under test and infrastructure server

1.
2.
3.

Select the Configuration tab, and select Storage.
Click on Add Storage..., select Network File System, and click Next.
Enter Server IP and Folder information, and click Next.

Installing the EMC NAS Plugin on VMware ESXi 5.1 server under test and infrastructure

server
1. Upload the EMCNasPlugin-1.0-11.zip to a datastore accessible by all hosts.
2. Using PuTTY, open a connection to an ESXi 5.1 host.
3. Login using root credential.
4. Enter# esxcli software vib install -d file:///<path to plugin>/EMCNasPlugin-
1.0-11.zip
5. Reboot the server upon completion.

Setting up a VM to host Microsoft® Windows® Active Directory® server (AD0O1) on

(infrastructure server)

1.

L 0 N ok W

N S N T
w N B O

Connect to the infrastructure sever via the VMware vSphere client.

Login as root.

In the VMware vSphere client, under Basic Tasks, select Create a new virtual machine.
Choose Custom, and click Next.

Assign the name ADO1 to the virtual machine, and click Next.

Select infrastructure as the host, and click Next.

Select the appropriate storage, and click Next.

Choose Virtual Machine Version 8, and click Next.

Choose Windows, choose Microsoft Windows Server® 2008 R2 (64-bit), and click Next.

. For CPUs, select one virtual processor socket, and two cores per virtual socket, and click Next.
. Choose 4 GB RAM, and click Next.
. Click 1 for the number of NICs, select VMXNET3, connect to the PRIV-NET network, and click Next.

. Leave the default virtual storage controller, and click Next.
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14.
15.

16.
17.
18.
19.
20.
21.
22.

Choose to create a new virtual disk, and click Next.

Make the OS virtual disk size 40 GB, choose thick-provisioned lazy zeroed, specify external storage, and click
Next.

Keep the default virtual device node (0:0), and click Next.

Click Finish.

Right-click the VM, and choose Edit Settings.

Click the Resources tab, and click Memory.

Select Reserve all guest memory, and click OK.

Connect the VM virtual CD-ROM to the Microsoft Windows Server 2008 R2 installation disk.

Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM

1. Open a virtual machine console on ADO1.
2. Choose the language, time and currency, and keyboard input. Click Next.
3. Click Install Now.
4. Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
5. Accept the license terms, and click Next.
6. Click Custom.
7. Click the Disk, and click Drive options (advanced).
8. Click New—=>Apply—>Format, and click Next.
9. After the installation completes, click OK to set the Administrator password.
10. Enter the administrator password twice, and click OK.
11. Install VMware Tools. For more information, see
kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.
12. Reboot the server.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.
15. Change the hostname to AD01, and reboot when the installation prompts you.
16. Click Start>Run, and type diskmgmt .msc
17. Select a 40GB volume, name it profiles, format it NTFS, and assign it drive letter E.
18. Select another 40GB volume, name it share, format it NTFS, and assign it drive letter F'.
19. Select the last 40GB volume, name it folders, format it NTFS, and assign it drive letter G.
20. Set up networking for the data network:
a. Click Start=>Control Panel, right-click Network Connections, and choose Open.
b. Right-click the VM traffic NIC, and choose Properties.
Uncheck TCP/IP (v6).
d. Select TCP/IP (v4), and choose Properties.
e. SetthelPaddressas172.0.0.10/255.255.0.0
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Installing Active Directory and DNS services on ADO1
1. Click Start>Run, type dcpromo, and click OK.

2. At the Active Directory Domain Services Installation Wizard welcome screen, check the Use advanced mode
installation option, and click Next.

3. Inthe Choose a Deployment Configuration dialog box, select Create a new domain in a new forest, and click
Next.
At the FQDN page, type vdi . com, and click Next.
At the NetBIOS name prompt, leave the name VDI, and click Next.

4

5

6. At the Forest Functionality level, select Windows Server 2008 R2, and click Next.

7. At the additional Domain Controller Options, leave DNS server selected, and click Next.

8. At the System Folder Location screen, change to E : \ leave the default options, and click Next.
9. Assign a Directory Services Restore Mode Administrator account password, and click Next.

10. At the Summary screen, review your selections, and click Next.

11. Once Active Directory Domain Services finishes installing, click Finish, and restart the system.
12. Click Start>Run, and type dnsmgmt .msc

13. Create a reverse lookup zone for ADO1.

14. Create static entries for the infrastructure server and the servers under test.
Configuring the Windows time service on ADO1

To ensure reliable time, we pointed our Active Directory server to a physical NTP server.
1. Openacommand prompt.
2. Type the following:
W32tm /config /syncfromflags:manual /manualpeerlist:"<ip address of a NTP
server>"
W32tm /config /reliable:yes
W32tm /config /update
W32tm /resync
Net stop w32time
Net start w32time

Setting up DHCP services on AD0O1

Click Start=>Administrative Tools—>Server Manager—>Add Roles.

Select DHCP Server, and click Next.

At the Introduction to DHCP Server screen, click Next.

At the Specify IPv4 DNS Settings screen, type vdi . com for the parent domain.

Enter the preferred DNS server IPv4 address, and click Next.

A

At the Specify IPv4 WINS Server Settings screen, select WINS is not required for applications on the network, and
click Next.
7. At the Add or Edit DHCP Scopes screen, click Add.
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10.
11.
12.
13.
14.
15.

16.
17.
18.
19.
20.

21.

22

At the Add Scope screen, enter the Name DHCP Scope name.
In the next box, set the following values, and click OK.

e Start IP address=172.0.0.20

e End IP address=172.0.10.200

e Subnet mask=255.255.252.0

Check Activate This Scope.

At the Add or Edit DHCP Scopes screen, click Next.

Click Enable DHCP v6 Stateless Mode, and click Next.

Leave the default IPv6 DNS Settings, and click Next.

At the Authorize DHCP server dialog box, select Use current credentials.

At the Confirm Installation Selections screen, click Next. If the installation is set up correctly, a screen displays

saying the DHCP server install succeeded.

Click Close.

Click Start->Run, and type DHCPmgmt .msc
DHCP->ADO1.vdi.com—>IPv4->Server Options.

Right-click Server Options, and select Configure options.
Activate option 66 Boot Server Host Name.

e String value=<ip of the Provisioning server>
Activate option 67 Boot file Name.

e String value= ARDBP32.BIN

Click OK.

Installing XenCenter 6.2 on ADO1

1.
2.
3.

Double click the XenCenter.msi
Select the destination folder, click Next, and click install.
Click finish.

Installing Citrix XenServer 6.2 on server under test

1.
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10. At the Verify installation source, select Skip verification and select OK.
11.

Insert the installation media, and select Boot from disk.

At the Citrix XenServer Welcome screen, choose the appropriate keymap, and select OK.

At the Citrix XenServer setup screen, select OK.

At the EULA screen, select Accept EULA.

Select perform clean installation, and choose OK.

Select the primary disk for installation, and select OK.
Enable thin provisioning, and select OK.

At the installation source, select Local media, and select OK.

At the Supplemental Packs screen, select No.

Specify root password, and select OK.
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12. Select the appropriate network interface, and select OK.

13. Select Automatic configuration (DHCP).

14. Enter a new Hostname, and select automatic DNS configuration via DHCP.
15. Choose the geographical area, and select OK twice.

16. Choose use NTP for system time, and select OK.

17. Choose NTP is configured by my DHCP server, and select OK.

18. Select Install XenServer to confirm Installation.

19. Select OK to reboot the server.

Installing updates on Citrix XenServer 6.2 server under test

Open Citrix XenCenter, select Add a server, and add all Citrix XenServer servers.
Choose tools, and select Install Update.

Click next, and click Add to upload the new update.

Browse to the location of the update, and click open.

Select XS62E001.xsupdate, and click Next.

Select which hosts to apply the hotfix, and click Next.

Click next on the upgrade pre-check screen.

In the post-update options, select Automatic, and click Install update.
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Click Finish to exit the wizard.
10. Repeat steps 5-12 to install update XS62E002.xsupdate.

Configuring networking and storage repositories on Citrix XenServer 6.2 server under test
1. Open XenCenter, and select the Networking tab.

Select Add Network..., and choose Bonded Network.

Select the appropriate NICs, Active-passive as bond mode and 9000 MTU .

Select the Bond Network, click on Properties, and rename it PRIV-NET.

Click Add Network..., choose External network, and click Next.

Type Storage-NET as the name, and click Next.

Select the Bonded NICs, and set the VLAN and MTU to 9000.

Under IP Address configuration, click Configure..., and select Add IP address.
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Type Storage as the name, select the Storage-NET network, and enter the appropriate IP settings.
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o

. Select the Storage Tab, and click on New SR.
. Select NFS VHD, and click Next.

. Enter a name for the new SR, and click Next.

[
N

13. Enter a share name, and click Finish.

Setting up a VM to host the vCenter server (vCenter)

1. Logintothe infrastructure server with the VMware vSphere client.
2. Inthe VMware vSphere client, under Basic Tasks, select Create a new virtual machine.

3. Choose Custom, and click Next.
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Assign the name vCenter to the virtual machine, and click Next.

Select infrastructure as the host, and click Next.

Select the appropriate storage, and click Next.

Choose Virtual Machine Version 8, and click Next.

Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.

For CPUs, select one virtual processor socket, and four cores per virtual socket, and click Next.

. Choose 8GB RAM, and click Next.

. Click 1 for the number of NICs, select VMXNET3, connect to the PRIV-NET port group, and click Next.
. Leave the default virtual storage controller, and click Next.

. Keep the default virtual device node (0:0), and click Next.

. Connect the VM virtual CD-ROM to the Microsoft Windows 2008 R2 installation disk.

. Click Finish.

. Right-click the vCenter VM, and click Edit settings.

. Click the Resources tab, click Memory, check the Reserve all guest memory checkbox, and click OK.

. Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM

1.
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12.
13.
14.
15.
16.

Open a virtual machine console on vCenter.

Choose the language, time and currency, and keyboard input. Click Next.
Click Install Now.

Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
Accept the license terms, and click Next.

Click Custom.

Click the Disk, and click Drive options (advanced).

Click New—>Apply—>Format, and click Next.

After the installation completes, click OK to set the Administrator password.

. Enter the administrator password twice, and click OK.

. Install VMware Tools. For more information, see

kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.
Reboot.

Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
Enable remote desktop access.
Change the hostname to vCenter, and reboot when the installation prompts you.
Set up networking for the data network:
a. Click Start, Control Panel, right-click Network Connections, and choose Open.
b. Right-click the VM traffic NIC, and choose Properties.
Uncheck TCP/IP (v6).
d. Select TCP/IP (v4), and choose Properties.

e. Setthe IP address, subnet, gateway, and DNS server.
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17.
18.

Join the VDI domain.

Reboot the system.

Installing Microsoft SQL Server 2008 R2

1.
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10.
11.
12.
13.
14.
15.
16.
17.
18.

Insert installation media, and click OK to install .NET framework.

Wait for the SQL Installer to launch. On the left menu, click Installation.

Click New installation or add features to an existing installation. Click OK.

Enter the Product Key, and click Next.

Check the | accept the license terms checkbox, and click Next.

Click Install to install the Setup Support Files (required).

Resolve any issues displayed in the setup wizard, and click Next.

At the Setup Role screen, select SQL Server Feature Installation, and click Next.

Select the Database Engine Services, Full-Text Search, Client tools Backwards
Compatibility, Management Tools Basic and Complete, and click Next twice.

Accept instance configuration defaults, and click Next.

Accept defaults for disk space requirements, and click Next.

Click Use the same account for all SQL Server services, select NT Authority\System, and click OK. Click Next.
Select Mixed Mode, and enter a password for the SA account. Click Add Current User, and click Next.
Accept defaults for error reporting, and click Next.

Review installation configuration rules check, and click Next.

To begin installation, click Install.

At completion screen, click Close.

Run Windows Update to receive all updates and security patches.

Setting up a database and ODBC DSN for vCenter

1. From the server desktop, open Start=>All Programs—>Microsoft SQL Server 2008 R2—> Configuration Tools=>SQL
Server Configuration Manager.

2. Click SQL Server Network Configuration—>Protocols for MSSQLSERVER.

3. Right-click TCP/IP, and select Enabled.

4. Click SQL Services—>right-click SQL Server Browser, and select Properties.

5. Inthe SQL Server Browser Properties, select the Services tab, change the Start mode to Automatic, and click OK.
Repeat this step for the SQL Server Agent service.
Start the SQL Server browser service and the SQL Server Agent service.
From the SQL server desktop, open Start—>All Programs—>Microsoft SQL Server 2008 R2-> Configuration
Tools=>SQL Server Management Studio

8. Click Connect.

9. Select the Databases folder, right-click, and select New Database

10. Provide the name vcenter for the new database.

11. Click Options and change the recovery model from full to simple, and click OK.

12. From the desktop of the vCenter server, select Start>Run—>odbcad3?2.exe
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13.
14.
15.
16.
17.
18.

19.
20.
21.
22.

Click the system DSN tab.

Click Add.

Click SQL Server Native Client 10.0, and click Finish.

In the Create a New Data Source to SQL Server text box, type the connection name vcenter

For Server, select SQL, and click Next.

Change authentication to With SQL Server authentication using a login ID and password entered by the user,
type sa as the Login ID, use the password you defined in SQL server setup for the SA account, and click Next.
Select Change the default database to:, choose vCenter from the pull-down menu, and click Next.

Click Finish.

Click Test Data Source... to confirm correct configuration.

Click OK to create the vCenter ODBC connection.

Installing VMware vCenter 5.1

1.
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10.
11.
12.
13.
14.
15.
16.
17.

18.

19.
20.
21.
22.
23.

Log onto the vCenter as VDI \administrator

From the VMware vCenter 5.1 install media, click Autorun.

Click Run to start the install wizard.

Click the Install button on the VMware vSphere 5.1 Simple Install wizard.

Select the Install wizard language as English, and click OK.

At the Install wizard welcome screen, click Next.

At the End User Patent Agreement, click Next.

Agree to the License Agreement, and click Next.

Enter and confirm the password you wish to use with the Administrator account for vCenter Single Sign On, and
click Next.

Select Install a local Microsoft SQL Server 2008 R2 Express Instance, and click Next.

Enter and confirm the passwords for the DBA and SQL user accounts, and click Next.

Confirm the Fully Qualified Domain Name or IP address is correct, and click Next.

Check the Use network service account checkbox, and click Next.

Accept the default installation path, and click Next.

Accept the default https port, and click Next.

Click Install.

After Single Sign On completes, and vCenter Server installation begins, enter user information and a license key,
and click Next.

Select Use an existing supported database, and select the Data Source Name (DSN) for the connection to the
SQL Server: vcenter

Type sa as the database username, provide the password for the SA account, and click Next.

Select the system account for the vCenter Server service account, and click Next.

Keep the vCenter default ports, and click Next.

Select 1024 MB for the JVM memory, and click Next.

Click Install to finish the vCenter server installation.
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24. Click Finish to exit the wizard.

25. Click OK to confirm completion.

26. Click Exit on the installer.

27. Restart the server.

28. Using the vSphere client, log into the vCenter server as VDI \administrator
29. Right-click the root of vCenter, and click New Data center.

30. Name the New datacenter vdi

31. Add the infrastructure server to the datacenter.

32. Add the server under test tothe datacenter.

Setting up a database and ODBC DSN for Composer

1. Open avirtual machine console on vCenter.

2. From the server desktop, open Start=>All Programs—>Microsoft SQL Server 2008 R2-> Configuration Tools=>SQL
Server Management Studio
Click Connect.
Select the Databases folder, right-click, and select New Database

Provide the name composer for the new database.

From the desktop of the vCenter server, select Start>Run—2>odbcad32.exe

Click the system DSN tab.

Click Add.
10. Click SQL Server Native Client 10.0, and click Finish.
11. In the Create a New Data Source to SQL Server text box, type the connection name composer
12. For Server, select SQL, and click Next.

13. Change authentication to With SQL Server authentication using a login ID and password entered by the user,

3
4
5
6. Click Options, change the recovery model from full to simple, and click OK.
7
8
9

type sa as the Login ID, use the password you defined in SQL server setup for the SA account, and click Next.
14. Select Change the default database to:, choose composer from the pull-down menu, and click Next.
15. Click Finish.
16. Click Test Data Source... to confirm correct configuration.

17. Click OK to create the Composer ODBC connection.

Setting up VMware Horizon View Composer 5.2

1. Open the View5 media folder, and run the file named VMware-viewcomposer-5.2.0
At the Welcome screen and the Patents screen, click Next.
Accept the VMware end user license agreement, and click Next.

Leave the Destination folder as default, and click Next.

vk W

In the Database information box, type composer as the source name and sa as the user name. Enter the
password, and click Next.

Leave the default SOAP port, and click Next.

Click Install, and click Finish.
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8.

Restart the server.

Setting up a VM to host the VMware View connection server

1.
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15.
16.
17.
18.
19.
20.

Log into vCenter with the VMware vSphere client.

In the VMware vSphere client, browse to the ESXi host named infrastructure.
Click the Virtual Machines tab.

Right-click, and choose New Virtual Machine.

Choose Custom, and click Next.

Assign the name View Connection to the virtual machine, and click Next.
Select infrastructure for the host, and click Next.

Select the appropriate storage, and click Next.

Choose Virtual Machine Version 8, and click Next.

. Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.

. For CPUs, select one virtual processor socket, and two cores per virtual socket, and click Next.

. Choose 4GB RAM, and click Next.

. Click 1 for the number of NICs, select VMXNET 3, connect to the PRIV-NET port group, and click Next.
. Leave the default virtual storage controller, and click Next.

. Choose to create a new virtual disk, and click Next.

. Make the OS virtual disk size 40 GB, choose thick-provisioned lazy zeroed, specify the OS datastore on the

external storage, and click Next.

Keep the default virtual device node (0:0), and click Next.

Connect the VM virtual CD-ROM to the Microsoft Windows Server 2008 R2 installation disk.
Right-click the View Connection VM, and click Edit settings.

Click the Resources tab, click Memory, check the Reserve all guest memory checkbox, and click OK.
Click Finish.

Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM

1.
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Open a virtual machine console on View Connection.

Choose the language, time and currency, and keyboard input. Click Next.
Click Install Now.

Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
Accept the license terms, and click Next.

Click Custom.

Click the Disk, and click Drive options (advanced).

Click New—=>Apply—>Format, and click Next.

After the installation completes, click OK to set the Administrator password.

. Enter the administrator password twice, and click OK.

. Install VMware Tools. For more information, see

kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.
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12.
13.
14.
15.
16.

17.
18.

Reboot.

Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
Enable remote desktop access.

Change the hostname to ViewConnection, and reboot when the installation prompts you.

Set up networking for the data network:

Click Start, Control Panel, right-click Network Connections, and choose Open.

Right-click the VM traffic NIC, and choose Properties.

Uncheck TCP/IP (v6).

Select TCP/IP (v4), and choose Properties.
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Set the IP address, subnet, gateway, and DNS server.
Join the VDI domain.
Reboot the system.

Installing the VMware View Connection Server 5.2

1.
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Log into the server named View Connection.

Browse to VMware View installation media, and click VMware-viewconnectionserver-x86_64-5.2.0
Click Run.

At the Welcome screen, click Next.

Agree to the End User License Agreement, and click Next.

Keep the default installation directory, and click Next.

Select View Standard Server, and click Next.

At the Data Recovery screen, enter a backup password, and click Next

Allow View Server to configure the Windows firewall automatically, and click Next.

. Authorize the local administrator to administer View, and click Next.

. Choose whether to participate in the customer experience improvement program, and click Next.
. Complete the installation wizard to finish installing View Connection Server.

. Click Finish.

14.

Reboot server.

Configuring the VMware Horizon View Connection Server

1.
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10.

Open a Web browserto <view connection server FQDN>/admin

Loginas administrator

Under Licensing, click Edit License...

Enter a valid license serial number, and click OK.

Open View Configuration—>Servers.

In the vCenter Servers tab, click Add...

Enter vCenter server credentials, and click Next.

At the View composer screen, select View Composer co-installed with vCenter Server, and click Next.
At the View composer domains screen, click Add...

Enter full domain name and user credentials.
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11. At the storage screen select, Reclaim VM disk space, and Enable View Storage Accelerator.
12. Change the Default host cache size to 1024 MB, and click Next.
13. At the ready to complete screen, click Finish.

Installing and configuring vShield Manager 5.1

1. Download the OVA file from my.vmware.com/web/vmware/downloads.

On vCenter, select File=> Deploy OVF template....

Select the OVA package, and click Next twice.

At the End User Agreement screen, click Accept, and click Next.

Enter a name for the appliance, and select the infrastructure server to host the appliance.
Select the appropriate datastore, and click Next.

At the Disk Format, screen click Next.

At the Network Mapping, screen click Next.
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Click Power on after deployment, and click Finish.
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. Open Console and login using admin as the user and default as the password.
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. Enter Enabled mode by entering the password default:

manager> enable

Password:

manager#
12. Run the setup command to open the CLI setup wizard:

manager# setup

13. Enter IP settings, and save the new configuration.
14. Reboot the appliance.
15. Open a Web browser window, and enter the IP address assigned to the vShield Manager.
16. Log in using admin as the user and default as the password.
17. Under Configuration, Select Edit vCenter Servers, and enter vCenter credentials.
18. Choose Yes to trust the host connection, and accept the server certificate.
19. Select NTP Server setting, click Edit, and add NTP server settings.
20. Reboot the vShield Manager appliance.

Installing and configuring vShield Manager 5.1
1. Open a Web browser window, and enter the IP address assigned to the vShield Manager.
2. Login using admin as the user and default as the password.
3. Expand the Datacenters folder, and select the server under test.
4. Under Service, select install vShield Endpoint. Select vShield Endpoint installing latest version 5.1.2-0833297,
and click install.

5. Upon completion, reboot the server under test.
Setting up a VM to host Trend Micro Deep Security 9

1. Logintothe infrastructure server with the VMware vSphere client.

2. Inthe VMware vSphere client, under Basic Tasks, select Create a new virtual machine.
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Choose Custom, and click Next.
Assign the name Trend Micro Manager to the virtual machine, and click Next.

Select infrastructure as the host, and click Next.

3

4

5

6. Select the appropriate storage, and click Next.

7. Choose Virtual Machine Version 8, and click Next.

8. Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.

9. For CPUs, select one virtual processor socket, and two cores per virtual socket, and click Next.

10. Choose 8GB RAM, and click Next.

11. Click 1 for the number of NICs, select VMXNET3, connect to the PRIV-NET port group, and click Next.
12. Leave the default virtual storage controller, and click Next.

13. Keep the default virtual device node (0:0), and click Next.

14. Connect the VM virtual CD-ROM to the Microsoft Windows 2008 R2 installation disk.

15. Click Finish.

16. Right-click the vCenter VM, and click Edit settings.

17. Click the Resources tab, click Memory, check the Reserve all guest memory checkbox, and click OK.
18. Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM
1. Open a virtual machine console on XenDesktop.

Choose the language, time and currency, and keyboard input. Click Next.

Click Install Now.

Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.

Accept the license terms, and click Next.

Click Custom.

Click the Disk, and click Drive options (advanced).

Click New—>Apply—>Format, and click Next.

After the installation completes, click OK to set the Administrator password.
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. Enter the administrator password twice, and click OK.
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. Install VMware Tools. For more information, see
kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.

12. Reboot.

13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.

14. Enable remote desktop access.
15. Change the hostname to Trend Micro Manager, and reboot when the installation prompts you.
16. Set up networking for the data network:
a. Click Start, Control Panel, right-click Network Connections, and choose Open.
b. Right-click the VM traffic NIC, and choose Properties.
Select TCP/IP (v4), and choose Properties.
d. Setthe IP address, subnet, gateway, and DNS server.
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17.
18.

Join the VDI domain.

Reboot the system.

Installing Microsoft SQL Server 2008 R2

1.
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10.
11.
12.
13.
14.
15.
16.
17.
18.
19.

Insert installation media, and click OK to install .NET framework.

Wait for the SQL Installer to launch. On the left menu, click Installation.

Click New installation or add features to an existing installation. Click OK.

Enter the Product Key, and click Next.

Check the | accept the license terms checkbox, and click Next.

Click Install to install the Setup Support Files (required).

Resolve any issues displayed in the setup wizard, and click Next.

At the Setup Role screen, select SQL Server Feature Installation, and click Next.

Select the Database Engine Services, Full-Text Search, Client tools Backwards
Compatibility, Management Tools Basic and Complete, and click Next twice.

Accept instance configuration defaults, and click Next.

Accept defaults for disk space requirements, and click Next.

Click Use the same account for all SQL Server services, select NT Authority\System, and click OK. Click Next.
Select Mixed Mode, and enter a password for the SA account. Click Add Current User, and click Next.
Accept defaults for error reporting, and click Next.

Review installation configuration rules check, and click Next.

To begin installation, click Install.

At completion screen, click Close.

Run Windows Update to receive all updates and security patches.

Open Microsoft SQL Server Management Studio, and create the dsm database.

Installing Deep Security Manager

1. Double-click the Deep Security manager installer.
2. Select a language, and click Next.
3. At the welcome screen, click Next.
4. Accept the license agreement, and click Next.
5. At the Destination Directory screen, accept the default location, and click Next.
6. Select Microsoft SQL Server as database type, and enter database credentials. Click Next
7. Enter License key, and click Next.
8. At the Address and Ports screen, click Next.
9. Enter a Username and Password, and click Next.
10. At the Security Update screen, accept the default setting, and click Next.
11. At the Co-Located Relay screen, select Yes, and Include AntiMalware. Click Next.
12. At the Smart Protection Network, click Next. Click Finish.
13. Restart the Virtual Machine.
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Configuring Deep Security Manager

1. Opena Web browser window, type https://deepsecuritymanager:4119/, and enter administrator

credentials.

Select Computers, and click New.

Click Add VMware vCenter...

Enter vCenter credentials, and click next.

Enter vShield Manager server credentials, and click Next.
Accept the SSL certificates, and click Finish. Click Close.

Select Computers, and click New.

Click Add Directory...

Enter domain controller credentials, and click Next. Click Finish.
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Preparing ESXi server under test Deploying Deep Security virtual appliance
1. Select Computers=>vCenter->Host and Cluster.
Right-click the ESXi server under test, and select Actions.
Select Prepare ESX..., and click Next.
Select Yes to allow DSM to reboot the server. Click Finish.
After rebooting is complete, select Deploy a Deep Security Virtual Appliance now. Click Next.
Enter an appliance name, datastore, folder and management network. Click Next.
Provide an appliance hostname, and select enable DHCP. Click Next.

Select Thick provisioned as storage format. Click Finish.
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At the Activate Deep Security Appliance, select Activate appliance now, and click Next twice.
10. Select the default policy, and click Next. Click Close.

Setting up a Windows 7 Enterprise (x64) ESXi base image VM
1. Inthe vSphere client, connect to the vCenter Server, and browse to the infrastructure host.
Click the Virtual Machines tab.
Right-click, and choose New Virtual Machine.
Choose Custom, and click Next.
Assign the name as View-gold, and click Next.
Select the infrastructure host, and click Next.
Select the appropriate storage.
Choose Virtual Machine Version 8, and click Next.
Choose Windows, choose Microsoft Windows 7 (64-bit), and click Next.
. For CPUs, select one virtual processor socket and two core per virtual socket, and click Next.
. Choose 2GB RAM, and click Next.
. Click 1 for the number of NICs, select VMXNET 3, and click Next.

. Leave the default virtual storage controller, and click Next.
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14. Choose to create a new virtual disk, and click Next.
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15. Make the OS virtual disk size 24 GB, choose Thin Provision, specify the OS datastore on the external storage, and
click Next.

16. Keep the default virtual device node (0:0), and click Next.

17. Click Finish.

18. Click the Resources tab, click Memory, and check the Reserve all guest memory checkbox.

19. Click the Hardware tab, CD/DVD Drive, and Connect the VM virtual CD-ROM to the Microsoft Windows 7 x64
installation disk.

20. Click OK.

Installing Windows 7 Enterprise (X64) on ESXi base image VM
1. When the installation prompts you, press any key to begin setup.
Enter your language preferences, and click Next.
Click Install.
Accept the license terms, and click Next.
Select Custom, and select the drive that will contain the OS.
Click Install.
Type user for the username, and click Next.

Enter no password, and click Next.
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At the system protection screen, select Use recommended settings, and click Next.
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. Enter your time zone, and click Next.
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. Select the Work Network setting, and click Next.
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. Install VMware Tools, and select Complete Installation. For more information, see
kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.

13. Reboot.

14. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.

15. Join the domain and restart the VM.

Installing the VMware Horizon View 5 agent
1. Browse to the VMware Horizon View 5 media, and run the VMware-viewagent file.
Click Run.
At the Welcome screen, click Next.
Accept the VMware end user license agreement, and click Next.

Select defaults, and click Next.
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Enter the server name of the View Connection Server, and click Next.
7. Click Install.

Configuring Regedit for Quick prep (kb.vmware.com/kb/1026556)
1. Click Start->Run, and type regedit

2. Browse to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\vmware-viewcomposer-ga.
3. Right-click SkipLicenseActivation, and click Modify...
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4. Change the value from 0 to 1.
5. Shutdown the machine, and take a snapshot of the final disk image.

Deploying Virtual Desktops using VMware Horizon View.
1. Open the View Administrator.

2. loginasadministrator

3. Under Inventory click Pools, and then click Add...

4. Select Automatic Pool, and click Next.

5. Select Dedicated, and click Next.

6. Select View Composer linked clones, and click Next.

7. Type pool for the pool ID and display name, and click Next.

8. Leave the pool settings as defaults, and click Next.

9. Under Naming Pattern, enter an appropriate name pattern for the pool.

10. Under Pool Sizing, type 100 for Max number of desktops and the number of spare (power on) desktops.
11. Select provision all desktops up-front, and click Next.

12. Under persistent disk, change the disk size to 20480 .

13. Select Redirect disposable files to a non-persistent disk, type 4096 MB for Disk Size, and click Next.
14. Under Storage Optimization, click Next.

15. Under vCenter Settings, use:

e ParentVM: /vdi/vm/<name of parent vm>
e VM folder: /vdi/vm/Pool
e Host or cluster: /vdi/host/server under test
e Resource pool: /vdi/host/server under test/Resources
e Datastores=NFS datastore , Overcommit: Conservative
16. Under Advanced Storage Options, select Use View Storage Accelerator (OS disk, 7 days) and under Other
Options select Use native NFS snapshots (VAAI). Click Next (in the case of disk reclamation testing, select
Reclaim VM disk space instead of VAAI).
17. Under Guest customization, select the following:
e Domain: vdi.com
e AD container: CN=Computers
o Select Use Quick Prep, and click Next.
18. Click Finish.

Activating Trend Micro on ESXi VMs and performing Anti-Malware scan.

1. Opena Web browser window, type https://deepsecuritymanager:4119/ and enter administrator

credentials.

Select Computers, and browse to the vCenter virtual machines catalog.
3. Select and right-click the VMware Horizon View virtual machines.

Select Actions—=> Activate/Reactive.
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5.
6.
7.

Once the status changes to Managed Online, select all the virtual machines, and select Actions—=> Assign Policy...
Browse to Base Policy>Windows—=>Windows 7 Desktop, and click OK.
Once the policy has been applied, select all the virtual machines, and select Actions=>Full Scan for Malware.

Setting up a VM to host Citrix XenDesktop 7.0

1.
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Loginto the infrastructure server with the VMware vSphere client.

In the VMware vSphere client, under Basic Tasks, select Create a new virtual machine.
Choose Custom, and click Next.

Assign the name XenDesktop to the virtual machine, and click Next.

Select infrastructure as the host, and click Next.

Select the appropriate storage, and click Next.

Choose Virtual Machine Version 8, and click Next.

Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.

For CPUs, select one virtual processor socket, and two cores per virtual socket, and click Next.

. Choose 4GB RAM, and click Next.

. Click 1 for the number of NICs, select VMXNET3, connect to the PRIV-NET port group, and click Next.
. Leave the default virtual storage controller, and click Next.

. Keep the default virtual device node (0:0), and click Next.

. Connect the VM virtual CD-ROM to the Microsoft Windows 2008 R2 installation disk.

. Click Finish.

. Right-click the vCenter VM, and click Edit settings.

. Click the Resources tab, click Memory, check the Reserve all guest memory checkbox, and click OK.

18.

Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM

1.
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12.
13.
14.

Open a virtual machine console on XenDesktop.

Choose the language, time and currency, and keyboard input. Click Next.
Click Install Now.

Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
Accept the license terms, and click Next.

Click Custom.

Click the Disk, and click Drive options (advanced).

Click New—=>Apply—>Format, and click Next.

After the installation completes, click OK to set the Administrator password.

. Enter the administrator password twice, and click OK.

. Install VMware Tools. For more information, see

kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.
Reboot.

Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.

Enable remote desktop access.
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15. Change the hostname to XenDesktop, and reboot when the installation prompts you.

16. Set up networking for the data network:

e. Click Start, Control Panel, right-click Network Connections, and choose Open.
f. Right-click the VM traffic NIC, and choose Properties.

g. Uncheck TCP/IP (v6).

h. Select TCP/IP (v4), and choose Properties.

i. Setthe IP address, subnet, gateway, and DNS server.

17. Join the VDI domain.
18. Reboot the system.

Installing Citrix XenDesktop 7.0

1.
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8.
9.

Insert the XenDesktop 7.0 media.

Click Run, and Click OK to install .NET 3.5 SP1.

At the welcome screen, click Start.

Under Get Started, select Delivery Controller.

At the License Agreement screen, select | have read, and accept the terms of the license agreement, and click
Next.

At the core components screen, select: Delivery Controller, Studio, Director, License Server, and StoreFront and
click Next.

At the Features screen, select Install Microsoft SQL Server 2012 Express and Install Windows Remote Assistance,
and click Next.

At the Firewall screen, select automatic configuration, and click Next. Click Install.

Click Finish, and Launch Studio.

Configuring Citrix Studio Site

1.
2.

8.
9.

Click Get Started and Create a Site.

Select Configure the Site, and start delivering applications and desktops to users. Enter a name for the new site,
and click Next.

At the Database screen, click test connection, and select OK to create a database automatically. Click Next.

At the Licensing screen, select the appropriate license, and click Next.

At the Connection screen, select Citrix XenServer, and enter root credentials. Select Create a virtual machine
using Studio Tools (Machine Creation Services). Click Next.

At the resources screen, enter a name for the resources, and select the PRIV-NET network. Click Next.

At the Storage screen, select the NFS SR, and select Use same storage for virtual machines and Personal vDisk.
Click Next.

At the App-V Publishing screen, select No, and click Next.

At the summary screen, click Finish.

Configuring Citrix StoreFront

1.

Click on Citrix StoreFront->Stores.
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On the actions pane, click on create Store.

Enter a store name, and click Next.

At the Delivery Controller screen, click Add...

Enter the delivery controller name, and select XenDesktop as the type.
Enter the XenDesktop FQDN, and click OK.

At the Remote Access screen, select none, and click Create. Click Finish.

Setting up a VM to host the Citrix Provisioning Server

1.
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Loginto the infrastructure server with the VMware vSphere client.

In the VMware vSphere client, under Basic Tasks, select Create a new virtual machine.
Choose Custom, and click Next.

Assign the name PVS to the virtual machine, and click Next.

Select infrastructure as the host, and click Next.

Select a Datastore on external storage, and click Next.

Choose Virtual Machine Version 8, and click Next.

Choose Windows, choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.

For CPUs, select one virtual processor socket, and two cores per virtual socket, and click Next.

. Choose 4GB RAM, and click Next.

. Click 1 for the number of NICs, select VMXNET3, connect to the PRIV-NET port group, and click Next.
. Leave the default virtual storage controller, and click Next.

. Keep the default virtual device node (0:0), and click Next.

. Connect the VM virtual CD-ROM to the Microsoft Windows 2008 R2 installation disk.

. Click Finish.

. Right-click the vCenter VM, and click Edit settings.

. Click the Resources tab, click Memory, check the Reserve all guest memory checkbox, and click OK.

18.

Start the VM.

Installing the Microsoft Windows Server 2008 R2 operating system on the VM

1. Open a virtual machine console on PVS.

2. Choose the language, time and currency, and keyboard input. Click Next.

3. Click Install Now.

4. Choose Windows Server 2008 R2 Enterprise (Full Installation), and click Next.

5. Accept the license terms, and click Next.

6. Click Custom.

7. Click the Disk, and click Drive options (advanced).

8. Click New=>Apply—>Format, and click Next.

9. After the installation completes, click OK to set the Administrator password.

10. Enter the administrator password twice, and click OK.

11. Install VMware Tools. For more information, see

kb.vmware.com/selfservice/microsites/search.do?language=en US&cmd=displayKC&externalld=340.
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12. Reboot.

13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.

15. Change the hostname to PVS, and reboot when the installation prompts you.

16. Set up networking for the data network:

Click Start, Control Panel, right-click Network Connections, and choose Open.

Right-click the VM traffic NIC, and choose Properties.

Uncheck TCP/IP (v6).

Select TCP/IP (v4), and choose Properties.
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Set the IP address, subnet, gateway, and DNS server.
17. Join the VDI domain.
18. Reboot the system.
Installing SQL Express on Provisioning Services server
1. Open SQL Express 2005 Express directory, and run SQLEXPR.exe.
Accept the End user agreement, and click Next.
Click Install to install prerequisites.
At the Welcome screen, click Next.
Verify the system passes the system configuration check, and click Next.
Enter a name and organization, and click Next.
Select the default features, and click Next.

Select Windows authentication, and click Next.
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Check both boxes to Enable user instances, add user to the SQL Server administrator Role, and click Next.
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. Click Next for error usage reporting.

. Click Install.

. When completed, click Next, and Finish.

. Open Start>All Programs—> Microsoft SQL Server 2005-> Configuration Tools=>SQL Server Configuration
Manager.

14. Click SQL Server Network Configuration—=>Protocols for SQLEXPRESS.

15. Right-click TCP/IP, and select Enabled.

16. Click SQL server 2005 Services—=>right-click SQL server browser, and select Properties.
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17. In the SQL Server Browser properties, select the services tab, change the start mode to Automatic, and click OK.
18. Start the SQL server browser service.

Installing Citrix Provisioning Services 7
1. Click on Start>Administrative Tools—>Server Manager—>Features—>Add Features.

2. Select .NET Framework 3.5.1 Features, and click Add Required Role Services.
3. Click Next on the Web Server (ISS) screen.
4. Click Next on the Select Role Services screen, and then click Install.
5. Click Close on the successful installation screen.
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Open installation media, and click autorun.

6
7. Click Server Installation, and click Install Server.
8. Click Install to install the required items.
9. Atthe Welcome Screen click Next.
10. Click I accept the terms in the license agreement, and click Next.
11. Enter a user name and organization, select all users, and click Next.
12. Select a destination folder, and click Next.
13. At the Ready to install screen, click Install.
14. Click Finish on the Installation completed screen.
15. Click OK on the PVS Console warning.
16. Click Next on the Provisioning Services Configuration Wizard.
17. At the DHCP Services screen, select The service that runs on another computer.
18. At the PXE Services screen, select The service that runs on this computer.
19. At the Farm Configuration screen, select Create a farm, and click next.
20. At the Database Server screen, click Browse..., select the local SQLEXPRESS instance, and click Next.
21. At the New Farm screen, type the following, and click Next:
a. Database name= ProvisioningServices
b. Farm=farm
c. Site=site
d. Collection name=Collection
e. Farm Administrator group= vdi.local/Builtin/Administrators
22. At the New Store screen, type Store name Store. For Path, browse to the root of e : \, and click Next.
23. Enter the License Server name, and click Next.
24. At the User account screen, select Specified user account, enter administrator, vdi.com and Password twice, and
click the checkbox next to Configure the database for the account, click Next.
25. Keep the default number of days between password updates, and click Next.
26. Keep the primary interface and communication ports, and click Next.
27. Select Use the Provisioning Services TFTP service, and click Next.
28. Leave the stream service at default, and click Next.
29. Click Finish, and click Done.

Installing Citrix Provisioning Services Administrative Console

On the Provisioning Services 7 installation screen, click on Console Installation.
At the welcome screen, click Next.

Accept the licensing agreement, and click Next.

Enter a user name and organization name, and click Next.

Accept the default install path, and click Next.

Accept the default install type, and click Next.

Click Install and Finish.
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Setting up a Windows 7 Enterprise (x64) Citrix XenServer base image VM
1. In XenCenter, Select New VM.

Select the Windows 7 (64-bit) template, and click Next.

Type XD_gold as the name, and add a description for the new VM.

Select installation source, and click Next.

Choose a home server, and select Next.

Enter 1 as the number of vCPUs and 2048 MB for memory. Click Next.

Select the NSF SR for storage location, and click Next.

At the Networking screen, select the PRIV-NET network, and click Next.
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Click on Create Now.

Installing Windows 7 Enterprise (X64) on Citrix XenServer base image VM
1. When the installation prompts you, press any key to begin setup.

Enter your language preferences, and click Next.

Click Install.

Accept the license terms, and click Next.

Select Custom, and select the drive that will contain the OS.

Click Install.

Type user for the username, and click Next.

Enter no password, and click Next.
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At the system protection screen, select Use recommended settings, and click Next.
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. Enter your time zone, and click Next.
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. Select the Work Network setting, and click Next.
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. Run Citrix XenServer tool, and click Next at the Welcome screen.
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. Accept the License Agreement, and click Next.

=
o

. Accept the default location for installation, and click Next. Click Install.

. Reboot.

. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
17. Join the domain, and restart the VM.
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Installing Citrix XenDesktop 7.0 agent
1. Insert Citrix XenDesktop 7.0 installation media.
Click Start.
Select Virtual Delivery Agent for Windows Desktop OS.
Select Create a Master Image, and click Next.
At the HDX 3D Pro screen select No, install the standard VDA, and click Next.
At the Core Components screen, uncheck Citrix Receiver, and click Next.
At the Delivery Controller screen, select Do it manually, and enter controller address. Click Add, and click Next.

At the Features screen, select all features, and click Next.
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At the Firewall screen, click configure automatically, and click Next.
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10.
11.

At the summary screen, click Install.
Click finish to restart the VM.

Installing Provisioning Services Target Device and creating a vDisk

1.
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Insert Provisioning services 7.0 installation media.

Select Target Device Installation twice.

At the Welcome, screen click Next.

Accept the license terms, and click Next.

Enter a user name and organization, and click Next.

Accept the default location for installation, and click Next. Click Install.
Click Finish to launch Imaging Wizard.

At the Welcome screen, click Next.

For server, type PVS, and click Next.

. Select Create new vDisk, and select fixed. Click Next.

. Name the vDisk XD gold vdisk, and select click Next.

. For Microsoft Volume Licensing, click None, and click Next.

. At the configure Image Volumes, select Autofit, and click Next.
. For target device name, type PVS_ XD gold, and click Next.
. Click Optimize for Provisioning Services. Click Finish.

16.

When the vDisk has been completed, click No to Reboot the XD _gold VM, and shutdown instead.

Enabling Citrix XenServer VM to boot from Network.

1.
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8.

On XenCenter, right-click on the master VM, and select Properties.

Select Boot Options, and enable Network. Move it up to boot from network first.

Click OK, and power on the XD _gold VM.

When the VM boots, it will boot from PXE and Provisioning services will stream the vDisk to the device.
Log in as VDI\administrator.

Provisioning services will now copy XD gold to the vDisk.

Click Finish.

Shutdown XD gold.

Creating a VM template for Provisioning Services

1.
2.
3.

Shutdown XD gold Virtual Machine.
On XenCenter, right-click on the master VM, and select Convert to template.

At the prompt, click on Convert.

Deploying a Citrix XenDesktop pool with the Citrix XenDesktop Setup Wizard

1. Open the Provisioning services console=>Farm->sites—>site—>and right-click the PVS_XD gold vDisk, and
select Properties.
Change the Access mode to Standard Image (multi-device, read-only access).
3. Change the Cache type to Cache on device hard drive, and click OK.
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15.
16.
17.
18.
19.

On the Provisioning services console select>Farm—>sites—>site, right-click and select XenDesktop Setup
Wizard...

At the welcome, screen click Next.

Type XenDesktop for the XenDesktop Controller, and click Next.

Under Host Resources, select the host server under test, and click Next.

Enter credentials for server under test, and click OK.

Click VM gold template, click OK, and click Next.

. Select the the PVS_XD gold vDisk, and click Next.

. Select Create a new catalog, name it XD _catalog, and click Next.

. Select Windows Desktop Operating System, and click Next.

. At the User experience screen, select The same (static) desktop and Save changes, and store them on a separate

personal vDisk. Click Next.

. Type the following, and click Next:

e Number of virtual machines to create= 100

e VvCPUs=1

e Memory=2048 MB

e Local write cache=6GB

e Personal vDisk size=20GB

e Personal vDisk drive letter: P

e Boot mode= PXE boot.
Click Next.
At the Active Directory screen, select Create new accounts, and click Next.
For Active directory location, click VDl.com—> computers.
For Account naming scheme, type XD—-###, and click Next.
Click Finish.

Creating a Citrix XenDesktop Delivery Group

1.
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On XenDesktop Studio, click on Delivery Groups, and on the action pane, select Create Delivery Group.

At the Getting Started screen, click Next.

Select the XD catalog, and add all the available virtual machines. Click next.

At the Delivery Type, select Desktops. Click Next.

At the Users screen, click Add users..., and add a user group.

At the StoreFront screen, select Manually, using a StoreFront server address that | will provide later. Click Next.

Enter XD group as delivery group name and display name. Click Finish

Configuring the power policy for the desktop group

1. On XenDesktop Studio, click PowerShell and type:
Set-BrokerDesktopGroup XD catalog —-PeakBufferSizePercent 100
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Installing Trend Micro agents on Citrix XenServer VMs and performing Anti-Malware scan.

1.
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10.
11.
12.
13.
14.
15.

Using the provisioning server, Change the PVS XD gold vDisk to private mode.

Power on a virtual machine.

Browse to the Trend Micro agent for Windows, and execute the installer.

At the Welcome screen, click Next.

Accept the License Agreement, and click Next.

At the Custom Setup screen, select Anti-Malware, and select Will be installed on local hard drive. Click Next, and
click Install.

Click Finish, and turn off the machine.

Using the provisioning server, Change the PVS XD gold vDisk to standard mode and cache on device hard
drive.

Open a Web browser window, type https://deepsecuritymanager:4119/, and enter administrator

credentials.

Select Computers, and browse to the correct catalog.

Select and right-click the Citrix XenDesktop virtual machines.

Select Actions—> Activate/Reactive.

Once the status changes to Managed Online, select all the virtual machines, and select Actions=> Assign Policy...
Browse to Base Policy>Windows—>Windows 7 Desktop, and click OK.

Once the policy has been applied, select all the virtual machines, and select Actions—> Full Scan for Malware.

Applications and files installed on virtual machines for disk reclamation

To simulate the lifecycle of a virtual desktop, we installed all the available Windows updates on all virtual

desktops and the following applications:
1) Web Browsers

a)
b)
c)

Google Chrome™
Opera™
Mozilla Firefox

2) Messaging

a) Skype™
b) Yahoo!® Messenger
c) Digsby™
d) Google Talk™
e) AIM®
3) Media
a) Apple® iTunes®
b) VideoLAN® VLC™

c)

Apple QuickTime®

4) Runtimes

a)

Java™
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b) Microsoft .NET
c) Microsoft Silverlight®
d) Adobe® AIR®
e) Adobe Shockwave®
5) Imaging
a) Picasa™
6) Documents
a) Microsoft Office 2007 (trial)
b) Apache™ OpenOffice
c) TDF® LibreOffice™
d) Adobe Reader®
e) PDFCreator
7) Security
a) AVG®
b) AD-Aware™
c) Spybot® 2
8) Online Storage
a) Dropbox®
b) Google Drive™
c) Microsoft Sky Drive®
d) EMC Mozy®
9) Utilities
a) ImgBurn
b) RealVNC
10) Compression
a) 7-Zip
b) WinRAR
11) Developer Tools
a) Phyton
b) FileZilla
c) JDK
d) WinScp
e) PuTTY
12) Other
a) Google Earth™
b) Steam®

c) Evernote™
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We also imported four HD movies to iTunes (about 6 GB total), and imported about 100 mp3s to iTunes (300 to 500
MB total). We copied 10 PDFs or large Word documents (at least 1 GB).
We uninstalled 75 percent of installed apps, and we deleted half of the media files and half of the user

documents.
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ABOUT PRINCIPLED TECHNOLOGIES

5] We provide industry-leading technology assessment and fact-based marketing
Principled §ervices. We bring to every assignment extens'ive experience V\{ith and expertise
Technologies® in all aspects of technology testing and analysis, from researching new

g technologies, to developing new methodologies, to testing with existing and new
tools.

Principled Technologies, Inc.
1007 Slater Road, Suite 300
Durham, NC, 27703

www.principledtechnologies.com

When the assessment is complete, we know how to present the results to a
broad range of target audiences. We provide our clients with the materials they
need, from market-focused data to use in their own collateral to custom sales
aids, such as test reports, performance assessments, and white papers. Every
document reflects the results of our trusted independent analysis.

We provide customized services that focus on our clients’ individual
requirements. Whether the technology involves hardware, software, Web sites,
or services, we offer the experience, expertise, and tools to help our clients
assess how it will fare against its competition, its performance, its market
readiness, and its quality and reliability.

Our founders, Mark L. Van Name and Bill Catchings, have worked together in
technology assessment for over 20 years. As journalists, they published over a
thousand articles on a wide array of technology subjects. They created and led
the Ziff-Davis Benchmark Operation, which developed such industry-standard
benchmarks as Ziff Davis Media’s Winstone and WebBench. They founded and
led eTesting Labs, and after the acquisition of that company by Lionbridge
Technologies were the head and CTO of VeriTest.

Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

Disclaimer of Warranties; Limitation of Liability:

PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS TESTING, HOWEVER,
PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR IMPLIED, RELATING TO THE TEST RESULTS AND
ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE. ALL
PERSONS OR ENTITIES RELYING ON THE RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED TECHNOLOGIES, INC.,
ITS EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR DAMAGE ON ACCOUNT OF
ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.

IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN
CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES,
INC.’S LIABILITY, INCLUDING FOR DIRECT DAMAGES, EXCEED THE AMOUNTS PAID IN CONNECTION WITH PRINCIPLED TECHNOLOGIES, INC.’S
TESTING. CUSTOMER’S SOLE AND EXCLUSIVE REMEDIES ARE AS SET FORTH HEREIN.
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